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• 6—14 GHz Low Noise and Driver Amplifier

• 27 dB Small-Signal Gain

• 1.8 dB Typical Noise Figure

• 20 dBm Typical Output P1dB

• 10 dB Input and Output Return Loss

• 28 dBm Output IP3

• Single Supply from 3 V to 8 V, with 60 mA 
current draw

• 3 mm × 3 mm QFN Package

ARF1211Q3 is a low noise and driver amplifier designed for high data-rate applications. With 27 dB of linear gain,
1.8 dB noise figure, 20 dBm output P1dB and low-current operation, it is well suited to multiple roles in Satcom and
A&D radio systems. The circuit draws 60 mA from a single DC supply, and can be operated from 3 V, for minimum
noise figure (1.7 dB), up to 8 V, for higher output power (20 dBm P1dB). The part is internally matched to 50 Ω with
ESD protection.

The part is RoHS* compliant and built with the latest manufacturing techniques to optimize for reliability and quality
control.

Export from The Netherlands/EU, no licence.

Description

Functional Diagram

Applications
• Test and Measurement

• Aerospace and Defense

• Satcom

All not connected (N/C) pins should be 
connected to DC, RF and thermal ground.

*RoHS compliant — European Union Directive 2011/65/EU 

Pin Pin Name Description

3 RFIN RF Input

10 RFOUT RF Output

14 VDD Supply Voltage

1, 5, 6, 7, 8, 12, 13, 
15, 16

N/C Unconnected Pins

2, 4, 9, 11, Paddle GND Ground

Features

Please refer to 
Datasheet Design 
Guidelines for 
preferred 
features and 
applications

File->Info->Document Title
Don’t Change “Altum RF Datasheet”

Change 
“ARFxxxQy” in 
master slide to 
appropriate part 
number

Leave the orange 
notes. They won’t 
be exported but 
gives other users 
prompts for 
editing
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1. Parameters tested at 25ºC in laboratory environment with standard 50 Ω matched equipment.
2. Nominal bias of VDD = 5 V and IDDQ ≈ 60 mA (quiescent current)

Return loss for <50 GHz 
should be de-embedded. 
If greater than 50 GHz 
add additional subscript 
note for “Reference plane 
for the return loss is to 
the RF connectors of 
evaluation board”

Electrical Specifications1,2

Parameter Test Conditions Min Typ Max Units

Frequency Range 6 14 GHz

Small-Signal Gain

6 GHz

8 GHz

10 GHz

12 GHz

14 GHz

26.0

25.0

25.5

24.0

22.0

28.0

27.0

27.5

26.0

24.0

30.0

29.0

29.5

28.0

26.0

dB

Gain Flatness ±1 dB

Gain Variation over Temperature 0.02 dB/ºC

Noise Figure

8 GHz

10 GHz

12 GHz

1.7

1.8

1.8

dB

Input Return Loss

6 GHz

8 GHz

10 GHz

12 GHz

14 GHz

17.2

10.0

9.5

9.0

3.8

dB

Output Return Loss

6 GHz

8 GHz

10 GHz

12 GHz

14 GHz

14.7

11.0

10.0

11.0

9.4

dB

VDD Voltage 3 5 8 V

IDD Current 50 60 70 mA
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Return loss for <50 GHz 
should be de-embedded. 
If greater than 50 GHz 
add additional subscript 
note for “Reference plane 
for the return loss is to 
the RF connectors of 
evaluation board”

Electrical Specifications1,2

Parameter Test Conditions Min Typ Max Units

Frequency Range 6 14 GHz

Output P1dB

6 GHz 

8 GHz 

10 GHz 

12 GHz 

14 GHz

14

16

17

16

15

dBm

Output P3dB

6 GHz 

8 GHz 

10 GHz 

12 GHz 

14 GHz

15

16

18

17

16

dBm

Output IP3

POUT = +10 dBm/tone, ∆F = 11 MHz

6 GHz

8 GHz

10 GHz

12 GHz

14 GHz

15

24

25

25

21

dBm

https://www.altumrf.com/
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Return loss for <50 GHz 
should be de-embedded. 
If greater than 50 GHz 
add additional subscript 
note for “Reference plane 
for the return loss is to 
the RF connectors of 
evaluation board”

Electrical Specifications, 8 V Bias1,3

Parameter Test Conditions Min Typ Max Units

Frequency Range 6 14 GHz

Output P1dB

6 GHz

8 GHz

10 GHz

12 GHz

14 GHz

18

19

20

20

19

dBm

Output P3dB

6 GHz

8 GHz

10 GHz 

12 GHz 

14 GHz

19

20

21

21

20

dBm

Output IP3

POUT = +10 dBm/tone, ∆F = 11 MHz

6 GHz

8 GHz

10 GHz

12 GHz

14 GHz

20

28

28

28

28

dBm

3. Bias of VDD = 8 V and IDDQ ≈ 70 mA (quiescent current)

https://www.altumrf.com/
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Thermal and Reliability Data

Stresses at or above those listed under Absolute Maximum Ratings may cause permanent damage to the product. 
This is a stress rating only; functional operation of the product at these or any other conditions above those 
indicated in the operational section of this specification is not implied. Operation beyond the maximum operating 
conditions for extended periods may affect product reliability.

ESD Sensitive Device

These devices are ESD sensitive. Proper handling for assembly and use must be maintained at all times. Please see 
JEDEC JESD625B for further information. 

4. All thermal and reliability data is measured or simulated with 85ºC at the package base  (solder junction).
5. Thermal resistance is the difference between the package base (solder junction) temperature and the channel 

temperature, divided by the DC power consumption

Delete as 
appropriate

Refer to Datasheet Design Guidelines for Absolute 
Max Ratings per process 

CDM not required for die

Absolute Maximum Ratings

Parameter Conditions Min Max Units

Drain Voltage VDD 0 8.8 V

Drain Current IDD 0 125 mA

Total Dissipated Power 1 W

Maximum RF Input Power Peak power +22 dBm

Channel Temperature +150 ºC

Operating Temperature Range -40 +85 ºC

Storage Temperature Range -50 +125 ºC

Moisture Sensitivity Level IPC/JEDEC J-STD-020E MSL1

ESD Human Body Model (HBM) JEDEC JS-001-2023 Class 1B

ESD Charged Device Model (CDM) JEDEC JS-002-2022 Class C3

Parameter Conditions3,4 Value Units

Thermal Resistance (RTH)5
VDD = 5 V, No RF

VDD = 5 V, FIN = 10 GHz, PIN = -6 dBm, CW
138.5
79.2

ºC/W

Channel Temperature (TCH)
VDD = 5 V, No RF

VDD = 5 V, FIN = 10 GHz, PIN = -6 dBm, CW
132.9
107.8

ºC

Mean Time To Failure (MTTF)
VDD = 5 V, No RF

VDD = 5 V, FIN = 10 GHz, PIN = -6 dBm, CW
4.9 × 106

> 1 × 107
Hours

https://www.altumrf.com/
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Nominal Bias: VDD = 5 V, IDDQ ≈ 60 mA

Gain Reverse Isolation

Input Return Loss Output Return Loss

Broadband S-Parameters at 25 °C

Measured Performance – Small Signal
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Room temperature: VDD = 3 V, 5 V, and 8 V

Gain Reverse Isolation

Input Return Loss Output Return Loss

Noise Figure

Measured Performance – Small Signal
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Nominal Bias: VDD = 5 V, IDDQ ≈ 60 mA

Gain vs Output Power at 6 GHz PAE vs Output Power at 6 GHz

Gain vs Output Power at 10 GHz PAE vs Output Power at 10 GHz

Gain vs Output Power at 14 GHz PAE vs Output Power at 14 GHz

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background0
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Nominal Bias: VDD = 5 V, IDDQ ≈ 60 mA

Drain Current vs Output Power at 6 GHz Drain Current vs Output Power at 10 GHz

Drain Current vs Output Power at 14 GHz

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background50
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Nominal Bias: VDD = 5 V, IDDQ ≈ 60 mA

Output Power at P1dB Output Power at P3dB

Gain at P1dB Gain at P3dB

PAE at P1dB PAE at P3dB

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background
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Room Temperature: VDD = 3, 5 and 8 V

Gain vs Output Power at 6 GHz PAE vs Output Power at 6 GHz

Gain vs Output Power at 10 GHz PAE vs Output Power at 10 GHz

Gain vs Output Power at 14 GHz PAE vs Output Power at 14 GHz

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background0

10

20

30

40

-10 0 10 20 30

G
ai

n 
(d

B
)

Output Power (dBm)

3V

5V

8V

0

10

20

30

40

-10 0 10 20 30

G
ai

n 
(d

B
)

Output Power (dBm)

3V

5V

8V

0

10

20

30

40

-10 0 10 20 30

G
ai

n 
(d

B
)

Output Power (dBm)

3V

5V

8V

0

10

20

30

-10 0 10 20 30
P

A
E 

(%
)

Output Power (dBm)

3V

5V

8V

0

10

20

30

-10 0 10 20 30

P
A

E 
(%

)

Output Power (dBm)

3V

5V

8V

0

10

20

30

-10 0 10 20 30

P
A

E 
(%

)

Output Power (dBm)

3V

5V

8V

https://www.altumrf.com/


ARF1211Q3

Final Rev 1.0 12 Copyright © 2025

Room Temperature: VDD = 3, 5 and 8 V

Drain Current vs Output Power at 6 GHz Drain Current vs Output Power at 10 GHz

Drain Current vs Output Power at 14 GHz

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background45

55

65

75

85

-10 0 10 20 30

C
ur

re
nt

 (m
A

)

Output Power (dBm)

3V

5V

8V
45

55

65

75

85

-10 0 10 20 30
C

ur
re

nt
 (m

A
)

Output Power (dBm)

3V

5V

8V

45

55

65

75

85

-10 0 10 20 30

C
ur

re
nt

 (m
A

)

Output Power (dBm)

3V

5V

8V

https://www.altumrf.com/


ARF1211Q3

Final Rev 1.0 13 Copyright © 2025

Room Temperature: VDD = 3, 5 and 8 V

Output Power at P1dB Output Power at P3dB

Gain at P1dB Gain at P3dB

PAE at P1dB PAE at P3dB

Measured Performance – Large Signal

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background0
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Room Temperature: VDD = 3, 5 and 8 V, ∆F = 11 MHz 

OIP3 versus POUT/tone at 6 GHz OIP3 versus POUT/tone at 10 GHz

OIP3 versus POUT/tone at 14 GHz OIP3 versus Frequency at POUT/tone = 5 dBm

Measured Performance – Linearity

All  Plots must use a vector 
format (Paste->Special SVG or 
EMF)
All plots must have transparent 
background0
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Bill of Materials Evaluation Board Layout

Evaluation Board Schematic

J1 Pin Description

5 VDD

2,4,6,8,10,12 GND

1,3,7,9,11 Unconnected

J4 Pin Description

11 Thermistor (optional)

2,4,6,8,10,12 GND

1,3,5,7,9 Unconnected

Description Reference 
Designator

Quantity

ARF1211Q3 U1 1

10 nF 0402 Capacitor C16 1

100 pF 0402 Capacitor C17 1

10 µF 0603 Capacitor C18 1

5 Ω 0402 Resistor R11 1

10 Ω 0402 Resistor R12 1

Thermistor (optional) TH1 1

12 pin Samtec 
TSM-106-01-F-DH-P-TR J1,J4 2

Southwest Microwave 
2.92mm 1092-01A-6 J2,J3 2

Recommended land-pattern and sample board 
layout for 254 µm thick RO4350B are available on 
request. 
Contact Altum RF Application Support for further 
information. 

Evaluation board Schematic 
should be in black on white.
Convert in inkscape or kicad 
(NOT in Powerpoint)

Set white background to 
transparent
Picture Format->Color-> Set 
Transparent color

Mark components that are not 
populated as DNP
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Application Notes

Delete if not applicable

1. Bias Turn-on Sequence

The recommended bias sequence is as follows. Starting with all pins at 0 V:
i. Increase VDD from 0 V to desired drain voltage (5 V typical).
ii. Apply RF power.

To turn off the device, follow this sequence in reverse order.

2. Reflow Information

MSL level 1 as per IPC/JEDEC J-STD-020E.

3. Evaluation Board Notes

Use twisted pair or shielded DC leads when biasing up evaluation boards to prevent coupling and feedback on our 
parts with broadband gain. 

4. Application Schematic

The recommended Application Schematic to ensure fast turn on and turn off times simplifies the de-coupling 
circuitry compared to the Evaluation Board Schematic. It is recommended to place C17 as close as possible to pin 
14. 

Contact Altum RF for land patterns and advice on using ARF1211Q3.

https://www.altumrf.com/
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Outline Drawing

All dimensions are in millimeters.
Package leads and exposed pad are plated with NiPdAu.

Set white background to 
transparent
Picture Format->Color-> Set 
Transparent color

Package Information

 

 

 

 

 

 

 

 

    

    

    

  

    

 
  
 

 
  
 
  
 

    

 
  
 

    

     

    

 
  
 

     

          

     

          

       

     

       

   

    

YYWW is the date code
XXXX is the lot code
1211 is the part number
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Part Number Delivery Format Quantity

ARF1211Q3–TR500 Tape and Reel 500 pcs

ARF1211Q3–TR2500 Tape and Reel 2500 pcs

Export from The Netherlands/EU, no licence.

For further information please visit www.altumrf.com or contact us directly at  sales@altumrf.com.

Ordering Information

Document Information
Information provided by Altum RF is believed to be accurate and reliable. However, no responsibility is assumed by Altum RF for its use, nor for any 
infringements of patents or other rights of third parties that may result from its use. All information contained herein is subject to change without 
notice. Customers should obtain and verify the latest relevant information before placing orders. The information contained herein or any use of 
such information does not grant, explicitly or implicitly, to any party any patent rights, licenses, or any other intellectual property rights, whether 
with regard to such information itself or anything described by such information.

Advance: Expected performance based on feasibility analysis, simulations or measured data. All content is subject to change.
Preliminary: Measured performance based on prototype parts. Specifications including maximum and minimum values are subject to change.
Final:  Guaranteed performance of qualified and production released part.

Document Template: ARFDOC-1897081980-202625 (Rev: 1.0)
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mailto:sales@altumrf.com?subject=Information%20on%20ARF1211Q3
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